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1 Introduction 

1.1 About GFI MailArchiver 

GFI MailArchiver is a powerful yet easy-to-use email archiving solution. With GFI 
MailArchiver, you can archive all internal and external email into a central archive store. You 
can then easily manage the email archive stores from the web-based configuration of GFI 
MailArchiver. If you want to, you can also allow users to browse and search past emails via 
the web-based browse and search interface. 

1.2 About GFI MailArchiver Outlook Connector 

The GFI MailArchiver Outlook Connector is a plug-in that synchronizes GFI MailArchiver with 
Microsoft Outlook. The GFI MailArchiver Outlook Connector enables users to see the email 
messages archived by GFI MailArchiver in Microsoft Outlook. Archived emails are displayed in 
Microsoft Outlook in an organized folder structure, identical to that in the user‟s mailbox. 

 

Mailbox folder structure retrieval must be enabled in GFI MailArchiver for GFI 
MailArchiver Outlook Connector to display emails with the folder structure identical 
to the user‟s mailbox. 
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2 Using the GFI MailArchiver Outlook Connector 

When GFI MailArchiver Outlook Connector is installed, it will automatically register itself in 
Microsoft Outlook. Microsoft Outlook will automatically attempt to connect to GFI 
MailArchiver using the URL specified during installation. Synchronization with GFI 
MailArchiver takes place automatically at a specified time interval, or manually using the 
Outlook Connector status toolbar.  

The GFI MailArchiver Outlook Connector will automatically add the folder GFI MailArchiver 
Mailbox in the Microsoft Outlook folder list. By default only one mailbox will be available 
(the mailbox of the logged on user), however other mailboxes can be added later. 

A toolbar is displayed, showing the status of synchronization with the GFI MailArchiver 
server. 

 

By default GFI MailArchiver Outlook Connector synchronizes and displays emails 
sent and received within the last 365 days. For more information on how to 
configure the number of days to synchronize refer to: 
http://kbase.gfi.com/showarticle.asp?id=KBID001934 

2.1 Launching the GFI MailArchiver Outlook Connector 

The GFI MailArchiver Outlook Connector is launched automatically. 

1. Open Microsoft Outlook. 

2. At startup, the GFI MailArchiver Outlook Connector will automatically try to connect to the 
user credentials provided. 

 

Screenshot 1 – Enter authentication details 

3. If at startup the authentication fails, the user is asked to enter the username and 
password. 

2.2 The GFI MailArchiver Outlook Connector Mailbox 

When the GFI MailArchiver Outlook Connector is installed, it automatically deploys a new 
mailbox in the Folder List of Microsoft Outlook named GFI MailArchiver Mailbox.  

http://kbase.gfi.com/showarticle.asp?id=KBID001934
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2.2.1 Email Folders 

The archive of emails in the GFI MailArchiver Mailbox consists of the structure of email 
folders in the Microsoft Outlook mail folder. Normally this includes the Inbox and its sub-
folders, sent items and any other email folder.  

 

Mailbox folder structure retrieval must be enabled in GFI MailArchiver for GFI 
MailArchiver Outlook Connector to display emails with the folder structure identical 
to the user‟s mailbox. 

Email headers are displayed in their appropriate folder. When an email header is selected 
this is retrieved from the GFI MailArchiver server and displayed in the Microsoft Outlook 
reading pane. By default, the number of email headers stored is 100,000 but this number 
can be set as shown in the Maximum Number of Emails in Local Cache chapter. 

 

Screenshot 2 – Office 2003/2005/2007: Emails in the Outlook Connector inbox 



 

4 | Using the GFI MailArchiver Outlook Connector GFI MailArchiver – Outlook Connector User Manual 

 

Screenshot 3 - Office 2010: Emails in the Outlook Connector inbox 

2.2.2 Search 

GFI MailArchiver Outlook Connector enables the user to search in the archived mailbox for 
emails. On selecting Search button, Microsoft Outlook connects with the GFI MailArchiver 
server and loads the search page in a separate window. 

1. Select Search. 

 

The Search button in Microsoft Outlook 2010 is accessible in the GFI MailArchiver 
tab on the ribbon. In previous version of Microsoft Outlook, it is located in the GFI 
MailArchiver Outlook Connector Status toolbar. 

By default, GFI MailArchiver displays the simple search interface that enables you to search 
for text within emails. 

2. Key in the text to search for in the Search all archived emails for user text box. 

 

Use of wildcards is allowed as follows: 

» ? - Matches any single character. 

» Matches any string of characters. 

For example: 

To search for emails containing the word „Swiss‟, you can type „sw??s‟ or „sw*s‟ in 
the Search for box. 
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3. Select a date range from the Search through emails from list  

4. <Optional> If you are logged in with a user account that has access to other user 
accounts, the simple search will, by default, search through your emails only. 

5. Click . 

Emails that match the search query specified are displayed below the Search area. GFI 
MailArchiver displays up to 25 emails per page. If more than 25 emails matched the search 
query, GFI MailArchiver will spread the emails out on separate pages. 

To navigate through the search results pages, click on the page links provided. 

2.2.3 Advanced Search 

Click  to access the advanced search feature. 

 

Screenshot 4 - Advanced Search Options 

2. In the Advanced Search Options area, use the features described in Table 1 below to 
perform an advanced search. 

Table 1 - Advanced Search options 

OPTION DESCRIPTION 

Archive Store Defines the Archive Store where the search will be performed. Select one or more 
Archive Stores from the available list of Archive Stores. 

Sent date Defines the date when the email to search for was sent. 

Includes 
and/any 

Defines whether to display emails that match all conditions or emails that match any of 
the conditions. From the drop-down list select: 

» Any – Displays emails that match at least one of the conditions specified. 

» And – Displays emails that meet all the conditions specified. 
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3 Monitoring Outlook Connector 

3.1 The Status Toolbar (Microsoft Outlook 2000/3/7 only) 

 

Screenshot 5 – Outlook Connector status toolbar 

The status of GFI MailArchiver Outlook Connector is displayed in the GFI MailArchiver 
Outlook Connector Status toolbar. The GFI MailArchiver status is either Online, Offline 
or Synchronizing. 

 
The toolbar option is available only after Microsoft Outlook is first restarted. 

A quick view icon indicates the status of synchronization: 

 - The GFI MailArchiver server is online and no error occurred during synchronization. 

 - The GFI MailArchiver server is online but an error occurred during synchronization. 

 - An error occurred when trying to connect to the GFI MailArchiver server. 

 - GFI MailArchiver Outlook Connector is manually set to work offline. 

To initiate synchronization manually, click the GFI MailArchiver toolbar and select 
Synchronize now. 

3.2 The Outlook Connector Ribbon Tab (Microsoft Outlook 2010 Only) 

In Microsoft Outlook 2010, the GFI MailArchiver Outlook Connector status is displayed in the 
Microsoft Outlook ribbon in the Home tab. 

 

The GFI MailArchiver options are available only after Microsoft Outlook is first 
restarted. 

A quick view icon indicates the status of synchronization: 

 - The GFI MailArchiver server is online and no error occurred during synchronization. 

 - The GFI MailArchiver server is online but an error occurred during synchronization. 

 - An error occurred when trying to connect to the GFI MailArchiver server. 

 - GFI MailArchiver Outlook Connector is manually set to work offline. 

To initiate synchronization manually, click Synchronize now.  

3.3 Monitoring Synchronization 

To monitor the progress of synchronization: 

» Microsoft Outlook 2000/3/7: Click the GFI MailArchiver toolbar and from the drop down 
list select View Status. 

» Microsoft Outlook 2010: Click Status option. 
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Screenshot 6 – Synchronization Progress 

The synchronization process consists of three stages, during which GFI MailArchiver Outlook 
Connector: 

Stage 1: Connects - connects with the GFI MailArchiver server using the URL provided in 
the Settings dialog. 

Stage 2: Synchronizes email headers – downloads the email headers to a local 
database. 

Stage 3: Downloads emails - downloads the emails for offline access. 

Further details about each synchronization process is displayed in the Activity tab. 
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Screenshot 7 – Synchronization Summary 

When synchronization is complete, a summary is displayed, showing the: 

» Start Time: The time when synchronization was started. 

» Duration: The time taken for synchronization to complete. 

» Headers synchronized: The number of headers which were downloaded locally. 

» Emails downloaded: The number of whole emails downloaded locally for offline 
access. 
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Synchronization Errors 

GFI MailArchiver Outlook Connector may not be able to synchronize correctly with the GFI 
MailArchiver server due to various reasons. 

 

Screenshot 8 – Synchronization Error 

When an error occurs, review the error details within the Summary or click View errors to 
launch the Activity tab. 
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Screenshot 9 – Synchronization Activity List 

By default, the last 1000 synchronization activity events are recorded. To modify the number 
of synchronization activity events shown: 

1. Close Microsoft Outlook and navigate to: 

» Microsoft Windows XP and earlier: 

<C:\Documents and Settings\<user>\Local Settings\Application Data\GFI\MailArchiver 6\> 

» Microsoft Windows Vista and later: 

<C:\Users\<user>\AppData\Local\GFI\MailArchiver 6\> 

2. Open GeneralSettings.xml file using a text editor.  

3. Locate the MaxNumberOfErrors element and change the value from 1000 (default) to the 
desired number. 

4. Save and close GeneralSettings.xml.  

5. Open Microsoft Outlook to apply changes. 
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Synchronization History 

To monitor the history of all synchronization processes click the GFI MailArchiver toolbar, 
choose View Status and select the History tab.  

 

Screenshot 10 – Synchronization History 

The details of all synchronization attempts are listed. By default, the last 1000 
synchronization attempts are recorded. To modify the number of synchronization attempts 
shown: 

1. Close Microsoft Outlook and navigate to: 

» Microsoft Windows XP and earlier:  

<c:\Documents and Settings\<user>\Local Settings\Application Data\GFI\MailArchiver 6\> 

» Microsoft Windows Vista and later:  

<c:\Users\<user>\AppData\Local\GFI\MailArchiver 6\> 

2. Open GeneralSettings.xml using a text editor.  

3. Locate the MaxNumberofSyncHistory element and change the value from 1000 (default) 
to the desired number. 

4. Save and close GeneralSettings.xml. 
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3.4 Working Offline 

When working offline all features of GFI MailArchiver Outlook Connector are available but 
synchronization with the GFI MailArchiver mail archives is suspended. This feature can be 
used to reduce network bandwidth usage or when access to GFI MailArchiver is not 
available. 

To put GFI MailArchiver Outlook Connector in offline mode: 

» Microsoft Office 2000/3/7: Click the GFI MailArchiver toolbar and select Work Offline. 
Repeat the procedure to restart synchronization. 

» Microsoft Outlook 2010: Click Work Offline from the GFI MailArchiver tab in the 
Microsoft Outlook Home tab. 
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4 Configuring the GFI MailArchiver Outlook Connector 

When GFI MailArchiver Outlook Connector is installed on the user‟s machine, default settings 
are sufficient for the Outlook Connector to operate. However, various settings can be 
customized to suite the user‟s preferences. 

4.1 Synchronization Settings 

To access the GFI MailArchiver Outlook Connector settings launch Microsoft Outlook and  

» Microsoft Outlook 2000/3/7: From the Microsoft Outlook menu, click GFI MailArchiver 
and select Settings. 

» Microsoft Outlook 2010: From the GFI MailArchiver area in the Home tab, select 
Options  Settings… 

 

Screenshot 11 – The Advanced Properties dialog 

4.1.1 Change GFI MailArchiver Server URL 

 

Consult with your system administrator prior to changing the GFI 
MailArchiver URL. 

1. In the advanced properties dialog of the GFI MailArchiver Mailbox, type the new URL of 
the GFI MailArchiver server in the URL of GFI MailArchiver server: text box. 

2. Click Verify to confirm if the specified URL is the correct GFI MailArchiver server URL. If 
the verification is not successful, consult with your system administrator to specify the 
correct URL. 
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4.1.2 Customize the Synchronization Interval 

In the advanced properties dialog of the GFI MailArchiver Mailbox, specify the time interval 
to synchronize with GFI MailArchiver server in the Synchronization interval: text box. By 
default, GFI MailArchiver Outlook Connector synchronizes with the server every 5 minutes. 

4.1.3 Maximum Number of Emails in Local Cache 

In the advanced properties dialog of the GFI MailArchiver Mailbox specify the number of 
email headers to store in the user‟s local cache. By default the number of email headers 
stored is 100,000, but this can be changed by typing a new value in Maximum number of 
emails in local cache. When the number of emails specified here is exceeded, the oldest 
email headers stored are removed and replaced with the most recent emails. 

4.1.4 Offline Access 

GFI MailArchiver Outlook Connector enables users to access emails even when there is no 
connection to the GFI MailArchiver server.  

To configure Offline Access settings: 

1. Launch the GFI MailArchiver Outlook Connector properties window and select the Offline 
Access tab. 

 

Screenshot 12 – Configuring Offline Access 

2. To enable/disable Offline Access select/deselect the Enable support for Offline Access 
checkbox. 

3. If Offline Access is enabled, specify the number of days that you want to store the emails 
received locally in the Store locally the emails received in the last: text box. When 
emails become older than the number of days specified they are deleted from memory. Only 
email headers are kept for retrieval. 
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4.2 Adding a New Mailbox 

By default GFI MailArchiver connects only to one mailbox using the credentials specified 
during installation. To configure GFI MailArchiver Outlook Connector to connect with more 
than one mailbox: 

1. Load Microsoft Outlook data file management screen: 

» Microsoft Outlook 2000/3/7: Navigate to File ► Data File Management. 

» Microsoft Outlook 2010: Click File tab, select Account Settings button and click 
Account Settings… option. Select Data Files tab. 

 

Screenshot 13 – Adding a new mailbox 

2. From the dialog/tab, select GFI MailArchiver Mailbox and click Add…. 

 

Screenshot 14 – Selecting the type of storage 

3. Select GFI MailArchiver and click OK. A dialog will appear with the list of user mailboxes 
to which the connected user has access to. 
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Screenshot 15 – Selecting the user/s 

4. Select the mailbox to add and click OK. The new mailboxes will be added in the Microsoft 
Outlook Folder List. 

 
If the user does not have access to the mailboxes, the user list will be empty and 
an error message will appear. 

 

 

Screenshot 16 – Added Mailboxes 
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4.3 Database Settings 

GFI MailArchiver Outlook Connector stores the following data in a local database: 

» Email headers of all emails within the GFI MailArchiver mail archives 

» Emails which are accessible when there is no connection between GFI MailArchiver and 
Microsoft Outlook (Offline Access). 

To access these database settings:  

1. From the Microsoft Outlook mail folders, right-click the GFI MailArchiver mailbox to 
configure and select: 

» Microsoft Outlook 2000/3/7: Properties for “GFI MailArchiver Mailbox”… 

» Microsoft Outlook 2010: Data File Properties 

2. From the properties dialog, click Advanced. 

 

Screenshot 17 – Database settings 

The mailbox name, database path and database size are displayed in the GFI MailArchiver 
Outlook Connector dialog. 

Click Resynchronize email store to delete the locally stored database and resynchronize 
all data for that particular mailbox when Microsoft Outlook is restarted. 

4.4 Enabling/Disabling the GFI MailArchiver Outlook Connector 

The functionality of GFI MailArchiver Outlook Connector can be disabled so that no features 
are available: 

To disable or enable GFI MailArchiver Outlook Connector  

1. Navigate to Start ► Programs ► GFI MailArchiver Outlook Connector and select 
Enable Outlook Connector or Disable Outlook Connector. 

2. Restart Microsoft Outlook to enable or disable GFI MailArchiver Outlook Connector. 
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4.5 Language Settings 

By default, the GFI MailArchiver Outlook Connector search node is set to load in English. To 
change the search feature language: 

1. In Microsoft Internet Explorer load the following URL  

http://<hostname>/<GFI MailArchiver virtual folder name> 

For example:  

http://win2k3entsvr.master-domain.com/MailArchiver 

2. Key in your credentials (username and password used to login to Microsoft Windows) 
when prompted. 

3. Click the user name displayed on the upper right hand corner of the screen. 

4. From the Language options drop down box, select the language to display. 

5. Click Save. 

GFI MailArchiver will reload the web interface in the selected language. 
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5 Troubleshooting 

5.1 Introduction 

The troubleshooting chapter explains how you should go about resolving any software issues 
that you might encounter. The main sources of information available to users are: 

» The manual – most issues can be solved by reading this manual. 

» GFI Knowledge Base articles accessible from the GFI website 

» Web forum 

» Contacting GFI Technical Support 
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5.2 Outlook Connector Issues 

ISSUE ENCOUNTERED  SOLUTION 

GFI MailArchiver Outlook 
Connector shows a warning sign in 
Microsoft Outlook right after 
installation 

Cause:  

This behavior is normal. Once you install the GFI MailArchiver 
Outlook Connector, it would need to synchronize the emails with GFI 
MailArchiver. 

GFI MailArchiver Outlook 
Connector synchronizes and keeps 
only the last 365 days worth of 
emails. 

Cause:  

By default GFI MailArchiver Outlook Connector only synchronizes 
and keeps the last 365 days worth of emails. 

Solution: 

Default behavior can be modified by changing a special key in the 
GeneralSettings.xml configuration file:  

1. Close Microsoft Outlook, navigate to: 

» Microsoft Windows XP and earlier:  
<c:\Documents and Settings\user\Local Settings\Application 
Data\GFI\MailArchiver 6\> 

» Microsoft Windows Vista:  
<c:\Users\userA\AppData\Local\GFI\MailArchiver 6\> 

2. Open GeneralSettings.xml file using a text editor.  

3. Locate the SynchronizeDaysSpan element and change the value 
from 365 (default) to the number of days worth of emails to see in 
the Outlook Connector. 

Example: To view the last 5 years worth of emails set the line as: 

<SynchronizeDaysSpan>1826</SynchronizeDaysSpan> 

4. Save and close the GeneralSettings.xml file.  

5. Delete the local cache from the same directory. This is normally a 

long number with FDB extension. If you are not sure which one to 
delete, open the StoreSettings.xml and locate the Store ID attributed 
with the user whose cache you want to affect.  

6 Open Microsoft Outlook and synchronize GFI MailArchiver Outlook 
Connector with GFI MailArchiver to enable changes. 

GFI MailArchiver search page does 
not appear in the Search folder in 
Microsoft Outlook  

Cause: 

In Microsoft Outlook, the home page setting is disabled for non-
default stores. The GFI MailArchiver Mailbox is a non-default store, 
and is therefore affected by this policy. 

Solution: 

Refer to the KBase below for more details on how to solve this issue: 

http://kbase.gfi.com/showarticle.asp?id=KBID003452 

One of the following issues is 
encountered: 

» Cannot enable Offline Access 
from the settings dialog 

» Cannot set the number of days 
for Offline Access greater than 
a particular number 

Possible cause 

The offline access settings are automatically configured by the 
system administrator or the feature is disabled by the system 
administrator. 

Possible solution 

Consult these issues with your system administrator. 

http://kbase.gfi.com/showarticle.asp?id=KBID003452
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ISSUE ENCOUNTERED  SOLUTION 

GFI MailArchiver Outlook 

Connector is not synchronizing 
with GFI MailArchiver. 

Cause 1: 

No connection between the client machine and the GFI MailArchiver 
server. 

Solution 1:  

Check with your system administrator to confirm the URL of GFI 
MailArchiver. This can be modified from the GFI MailArchiver Outlook 
Connector settings dialog. 

Cause 2:  

GFI MailArchiver Outlook Connector is disabled 

Solution 2: 

Enable GFI MailArchiver Outlook Connector from Start ► 
Programs ► GFI MailArchiver Outlook Connector ► Enable 

Outlook Connector and restart Microsoft Outlook. 

GFI MailArchiver Outlook 
Connector stops synchronizing 
when laptop power supply is 
switched to battery. 

Cause: 

By default GFI MailArchiver Outlook Connector stops synchronizing 
when the power supply of a laptop is switched to battery to reduce 
battery power consumption. 

Solution: 

To synchronize GFI MailArchiver Outlook Connector when utilizing 
the battery as a power source:  

1. Navigate to: 

» Microsoft Windows XP and earlier:  
<c:\Documents and Settings\user\Local Settings\Application 
Data\GFI\MailArchiver6\> 

» Microsoft Windows Vista:  
<c:\Users\userA\AppData\Local\GFI\MailArchiver6\> 

2. Open GeneralSettings.xml using a text editor.  

3. In the list of elements, add a new element called 
IgnorePowerStatus and assign a value of 1, as follows: 

<IgnorePowerStatus>1</IgnorePowerStatus> 

4. Save and close GeneralSettings.xml. 

Synchronization errors: 

HTTP Errors 

Possible cause: 

HTTP errors are due to network configuration issues. 

Possible solution: 

For more information refer to: 

http://support.microsoft.com/kb/324069 

http://msdn.microsoft.com/en-us/library/ms524996.aspx 

http://support.microsoft.com/kb/907273 

Synchronization errors: 

HTTP Error 500 

Possible cause: 

The GFI MailArchiver server is busy or inaccessible. 

Possible solution: 

Resynchronize the Outlook Connector within a few minutes. 

http://support.microsoft.com/kb/324069
http://msdn.microsoft.com/en-us/library/ms524996.aspx
http://support.microsoft.com/kb/907273
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ISSUE ENCOUNTERED  SOLUTION 

Synchronization errors: 

GFI MailArchiver connection 
timeout 

Possible cause: 

The GFI MailArchiver server is busy and failed to send the required 
data in a specified time interval. 

Possible solution: 

To increase the timeout value:  

1. Navigate to: 

» Microsoft Windows XP and earlier:  
<c:\Documents and Settings\user\Local Settings\Application 
Data\GFI\MailArchiver6\> 

» Microsoft Windows Vista:  
<c:\Users\userA\AppData\Local\GFI\MailArchiver6\> 

2. Open GeneralSettings.xml using a text editor.  

3. Locate the TryConnectionTimeout element and increase the 
default value of 120000. 

4. Save and close GeneralSettings.xml. 

5.3 Knowledge Base  

GFI maintains a Knowledge Base, which includes answers to the most common problems. If 
you have a problem, please consult the Knowledge Base first. The Knowledge Base always 
has the most up-to-date listing of technical support questions and patches. To access the 
Knowledge Base, visit http://kbase.gfi.com/. 

5.4 Web Forum 

User to user technical support is available via the web forum. The forum can be found at: 
http://forums.gfi.com/.  

5.5 Contact Technical Support 

If you have referred to this manual and our Knowledge Base articles, and you still cannot 
solve issues with the software, contact the GFI Technical Support team by filling in an online 
support request form or by phone. 

» Online: Fill out the support request form on: 
http://support.gfi.com/supportrequestform.asp. Follow the instructions on this page 
closely to submit your support request. 

» Phone: To obtain the correct technical support phone number for your region please 
visit: http://www.gfi.com/company/contact.htm. 

 

Before you contact our Technical Support team, please have your Customer ID 
available. Your Customer ID is the online account number that is assigned to you 
when you first register your license keys in our Customer Area at: 
http://customers.gfi.com. 

We will answer your query within 24 hours or less, depending on your time zone. 

 

http://kbase.gfi.com/
http://forums.gfi.com/
http://support.gfi.com/supportrequestform.asp
http://www.gfi.com/company/contact.htm
http://customers.gfi.com/
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makes no warranty, express or implied, and assumes no legal liability or responsibility for the accuracy or 
completeness of any information contained in this document.  

If you believe there are any factual errors in this document, please contact us and we will review your concerns 
as soon as practical. 
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